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Introduction

This manual contains information about the WordPress Property Listing (WPL) Plugin.

WPL is a powerful plugin that provides the ability for real estate websites using WordPress to

conveniently add and manage properties, property agents, as well as offer access management

and memberships for users. WPL is designed to handle small companies with a few agents as

well as large companies with many agents. WPL has many customizable options, themes,

packages, and installable Add-ons.

Using a mighty and easy form creator, WPL allows the website admin to freely customize

property/listing fields. For example, if the admin wants to have a select box (or textbox) to add

frontend information, which (by default) has not been included in WPL, the Flex Menu can be

used to create this field. Form elements such as bedroom, price, half bathrooms, etc. can be

made mandatory, enabled, or disabled with just a few clicks in the Flex function.

By using WPL, you can list properties on your website with different criteria. For example, you

can create a menu for showing featured properties or another menu for showing rental or

vacation listings. You can also list your agents by creating a Profile/Agent listing menu and your

visitors can see all of your agents or specific agent's properties by using this menu.

Visitors can search properties by using search widgets, browse properties on the map, see

property details and many other fantastic features.
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System Requirements

1. WPL can install and work on most of the standard web servers but please check

following article for a list of WPL Server requirements:

System Requirements for using WPL and Add-ons

Glossary

Below is a list of terms and their meanings used throughout this manual.

Activity: An internal WPL widget used to show some parts of the WPL interface. For example,

Google Maps is shown by using an activity in WPL. Activities are contained inside of WPL views

(not WordPress sidebars).

Add-on: An Extension that can be installed on WPL which will introduce new features such as

the MLS Add-on and the Pro Add-on.

Add/Edit Listing: The interface for adding/editing properties.

Agent: A WordPress user that is active in WPL and can have access to different sections of WPL

based on the access level given. These accesses include the ability to add/edit properties and

the limitations can be determined by the website administrator.

Carousel Widget: This WordPress widget can be used to showcase properties in different

layouts. Normally this is placed on the homepage of your site and can show either random or

specific properties.

Flex Add-on: Allows you to manage the data fields of the properties. You can add/edit/delete

fields through this Add-on.

https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/529/
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Google Maps Activity: An activity used in WPL to show properties based on their

coordinates on the map service of the Google website. This activity can be loaded in Property

Listing and Property Show.

Listing Manager: The interface for showing the list of properties with some statistics and

editing tools.

Listing Types: Defines property terms that are either for sale, for rent, or for vacation rental.

Profile Edit: The interface for editing agent information and details. Each agent has their own

profile wizard (My Profile menu) and should fill in the data and upload pictures for their profile

icon and company logo.

Property OR Listing: The properties (e.g. apartment, land, office, etc.) that are listed on the

website through WPL.

Property Details Page (Property Show): The page that includes the detailed information of an

individual property.

Property Listing: A page for showing the list of properties to site visitors with pagination. The

property listing can be generated through the search widget or through pre-defined menus

such as "For Sale" or "For Rent" menus.

Property Types: Defines various types of properties (i.e. Apartment, Villa, Condo, House, Office

etc.).

Search Widget: This WordPress widget is used to search through the properties of the website.

This dynamic function provides your site with various instances and different settings for

diverse purposes.

WPL: WordPress Property Listing

WPL Frontend: The WPL interface on a WordPress site for the end-users. This is what visitors

and users will view when they access your website.
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WPL Backend: The WPL interface working in the WordPress administrator section. It is the

behind-the-scenes of your website which visitors and restricted users cannot see or have access

to, but it generates what is seen on the frontend.
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Installation

If you have the installation package of WPL, you can easily upload it from the following path:

WordPress->Plugins->Add New->Upload

If you do not currently have the installation package, you can find the latest version of WPL in

https://wordpress.org/plugins/real-estate-listing-realtyna-wpl/

Also you can install the WPL directly from WordPress->Plugins->Add New. You should activate

the plugin after installation.

The WPL plugin widgets such as search, carousel and agents along with some other features are

included in WPL package, which can be found upon activating WPL.

You can also purchase advanced themes, more Add-ons and features from our official website:

https://realtyna.com/shop/wpl-shop/

These Add-ons and features include MLS/RETS integrations, PRO Add-on, more professional

themes, etc. There is also the option to order any customized features and themes.

Getting Started

Immediately after installing and activating the WPL, you can use it out of the box. You just need

to add your listings! BTW, you may need to configure some parts of WordPress and WPL based

on your needs.

WordPress Configuration

It's recommended to use one of WPL native themes or compatible themes. If you're using the

PRO version of WPL, then you can install and use Theme28 of WPL. You should receive this

theme upon purchasing WPL PRO.

It is not mandatory to use WPL themes. You can also use your preferred WordPress theme.

However, you may need to make some CSS/HTML tweaks in the WPL interface in order to

match your desired WordPress theme.

https://realtyna.com/shop/wpl-shop/
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If you want to show listings on the homepage of your website, you just need to create a

Home page and put [WPL] shortcode into the page. You shouldn't use the WPL Properties page

as the home page.

For adding WPL pages in your website menu, you should use Appearance->Menus. First, select

the menu group that you want to work on from the top of the page. Based on your WordPress

theme, they may be listed in order of Top Menu, Footer Menu, Side Menu, etc.

The next step is selecting the page that you want to assign to the new menu. Type the menu

name and click on Add to Menu. Then you should select the right position for the new menu

among other menus. The final step is to click on the Save Menu button on top of the page.

For adding WPL search and WPL carousel widgets you can use Appearance->Widgets and

include them in your theme's sidebars.

Also, you should set WordPress Permalink Setting to one of the advanced options. You can find

this option on the Settings->Permalinks menu.
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WordPress Configuration

After the installation, a menu named WPL will be added to the admin section of the website.

You can manage all of the administrative activities

of the WPL through this menu.

WPL has a very advanced and flexible data

structure. It allows you to add/edit property fields

of the "Add Listing" menu from the administration

section through the Flex Add-on without any

programming.

Additionally, you can manage the Property Types

(such as Apartment, Villa, Office, Land, etc.) and

Listing Types (such as For Sale, For Rent, Vacation

Rental, Student Accommodation, etc.). These types

are pre-populated by some default values, but you

can always add more fields or edit/delete existing

ones.

Furthermore, you can:

·         Change the position of items by dragging and dropping them

·         Change enabled/disabled status of items, modifying details, etc.

·         Manage unit types, room types and property sort options

·         Manage WPL Settings
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·         Manage your profile information. This data will be shown in the Frontend of the

website on pages such as Listing Details and the Agent page. If you fill in all of the fields, you

will have a better view on the frontend.

·         Manage users by adding new WordPress users into WPL as agents. If needed you can add

some users from Users->Add New menu first and then add them to WPL. You can assign specific

access and limits for your agents by clicking on the edit icon too.

Remember to change the default currencies of WPL as needed. For example: If your currency is

C$ you should enable it from "Unit Manager" and disable other useless currencies.

Warning: Do not change any settings that you are not familiar with or certain of!

Add Listings

You can simply add your listings from WPL->Add Listing menu. Also, you can manage previously

added listings from WPL->Listing Manager menu.

WPL Backend

Dashboard

On this page, you can view the WPL change-log, as well as the related add-ons that can be

acquired separately for adding more features to your website.

You can also see shortcuts and update messages on this page. Only admins have access to this

menu and agents cannot see it.

Related KB Articles
How do I update WPL PRO?

How do you upgrade WPL basic to WPL PRO?

How do I download my purchased products?

https://support.realtyna.com/index.php?/Knowledgebase/Article/View/557/28/how-to-update-wpl-pro
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/561/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/703/


10

Data Structure

By using this page you can manage some of the most important sections of WPL, such as Listing

Types, Property Types, and Units.

Property Types

You can add/edit/delete/enable/disable Property types from this page. To add a new listing

type, simply click on the + icon.

Listing Types

You can add/edit/delete/enable/disable Listing types from this page. To add a new listing type,

simply click on the + icon.

In order for your listings to show on Google Maps, you must assign a Google marker to each

listing type. You can also add new marker icons and delete them by using the Google icon block.

Note: You can also set Advanced Markers in the “Settings” section.

Unit Manager

Use this tab for managing WPL units. The default view is set to show currencies, but you can

select the unit type from the top of the page to manage the units. You should have some

enabled units in currency, length and area. You can also change the position of units.

Note: The top unit in each category will be the default unit in WPL.

It is mandatory to have at least one longer length unit such as "km" and "mi". The larger length

unit is needed in some cases, such as a radius search.

It is required that at least one unit should be enabled for each unit type.
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Sort Options

You can enable/disable your desired sort options here. These Sort options will be shown on

each property listing, profile listing, carousel widget and also on the shortcode wizard. The sort

options are in a default order, but you have the option to change the position of them as well.

Room Types

This page is used for managing room types in WPL. You can add a new room type and manage

current room types. These room types will show on the property wizard page when adding a

property. You can specify a property's number of rooms and assign width and height for each

room. The data for each room will be shown on the property show page.

Note: For showing data for each room in the property show page, room activity must
be included in your theme.

Related KB Articles

How do I enable/disable WPL measuring units such as acre, mile, currency, etc?

How to manage (Add/Edit/Delete) Listing Types or Property Types

How do I set WPL sort options?

How do I add new units of measurement (acre, mile, currency, etc.) to WPL?

Flex

The most interesting WPL feature is the Flex and its structure. The power of Flex allows you to

easily customize your property structure. You can add your desired fields based on your needs

and change the sorting of them. You can also make some fields mandatory or not.

https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/542/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/583/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/687/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/662/
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For adding new fields into WPL, you can select the type of field you need and then click on the

Add button.

You should select the proper field type

and then add it to WPL.

The most frequently used field types are

"text", "select" and "number".

If you need a special field such as

"feature" or "appliances" be sure to

select the proper field type.

Note: The gear icon in WPL is developed

for customization purposes. By default, it

set, so do not put any data into it if you

do not need it.
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Each field type has its own parameters and will present a different form after making the

selection.

For example, if you choose the "select" field type, you must specify multiple values for it. If you

choose the "date" field type, you must insert the date ranges into the Flex form. Please view

the figure below:

In general options, you should specify the category of each field and also the field name. The

text search option is for including the value of the field into the text search feature.
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In a specific option, you can make the field specifiable or not. By default, it is not

specifiable. You can choose to make it listing-specific or property type-specific.

For example, Bedroom is a property type-specific field. It's specified to Apartment and Villa by

default because Offices do not have a bedroom field. Price type is a listing-specific field related

to For Rent and Vacation Rental listings.

You should assign values of the selected field in the parameters section and then click "Save"

button to save the field.

One option worth noting is: “If Zero.” This option lets you assign a function if a value is zero. For

example, on a “Land” listing, if the number of “bedrooms” is 0, you can choose to hide this

field.

Note: New fields will be shown in the "Search Widget" available fields and "Property Show"

page. They are not shown on the "Property Listing" page by default and you should customize

your theme if you want to add them into the property listing.

Related KB Articles

How do I create new fields and edit current fields in WPL? How do I use the Flex menu?

How do I create property type and listing type-specific fields in WPL?

How do I hide zero values in the property listing and other WPL pages?

How do I add "call for price" in WPL PRO?

Bedrooms, rooms, and other fields are not appearing for new listing or property types.

Locations

You can manage your locations and settings through this menu. By default, WPL has all the

countries and states of the United States (US).

If you would like to work in a country other than the United States, you will need to enable your

desired country first.

https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/541/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/539/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/597/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/592/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/540/
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Note: When you enter a Location Level, you will have the opportunity to enter an

abbreviated version of the name to aid in the search. ie- United States will automatically add US

as an abbreviation. Los Angeles could be abbreviated to LA and so on.

After enabling a country, insert the secondary level locations, such as the states or provinces. To

do this, click on "Load Next Level" next to the country name and then click on the + icon next to

breadcrumb activity and insert all of the locations one by one.

If you click on the settings icon next to the page title, you can see "Location Settings". You can

insert your desired location names and select proper configurations based on your country’s

location system.

By filling in location keywords, you can easily change the label of the locations in the WPL. For

example, you can change the label of the secondary location level from "State" to "Territory" if

needed.
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You can select the zip code

parent level by changing its

settings. If you do not need a

"County" location level, you can

simply remove its label and

insert "City" as location 3.

WPL can support 2 location

methods:

Location Database

By using this method, all location

levels will be shown as

drop-down menu boxes and

agents can only pick a location

from ones that exist in the

database. This means that you

need to enter all location levels,

including states, cities, counties,

etc., manually from the location

management menu in the

backend of WPL.

Location Text

By using this method, WPL

shows Country and State as

drop-down menu boxes in the

Property wizard or Profile wizard (wherever it is needed) and shows other location levels as text

input. By using this method you do not need to add any locations into the database and your

agents can insert the address of each property easily by typing it in. This is the default method

of the WPL system and it is highly recommended.
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Related KB Articles
How do I use the Location Manager in WPL?

How do I enable new countries in WPL?

How do I add/remove a location level in WPL?

Hierarchal Drop Downs

Settings

By using this menu you can manage all the WPL global settings in one place. Based on the

Add-ons you installed on your website or any customizations you might have, the setting

options can be more or less.

Note: If you wish to make your plugin compatible with Right to Left languages, you should

change the site language in WP Settings > General > Site Language. WPL will automatically

switch to the RtoL style.

https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/527/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/586/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/562/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/709/
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Related KB Articles

What is the difference between the image resize methods?

How do I use the WPL Geo Meta Tag feature?

How do I enable the WPL RSS feed feature?

How do I adjust the WPL address pattern?

How do I enable the WPL Watermark feature?

How to change main color of the WPL frontend?

Why aren't my thumbnail photos changing in my listings?

How do I add a print option on a listing page?

How do I change the WPL date format?

How to enable new WPL Cronjob system?

How to add Google Recaptcha to various forms?

How to hide/show listing visits from property listing page?

Make WPL RTL for Arabic, Hebrew and Persian languages.

Activity Manager

Activities create some part of WPL interfaces on the frontend. For example, the map that you

see in the property listings and property details pages is an activity and you can manage it from

this menu. You can find more information about each activity in WPL Activities section of this

manual.

https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/558/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/582/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/643/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/574/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/593/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/708/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/699/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/705/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/568/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/776/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/685/
https://support.realtyna.com/index.php?/Knowledgebase/Article/View/823/0/how-to-hide-listing-visits-in-property-listing-pages
https://support.realtyna.com/index.php?/Knowledgebase/Article/View/814
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Related KB Articles

How do you modify and change settings for items in the WPL Activity Manager?

Enabling/Disabling/Sorting WPL Activities.

How do I disable Google Maps in the listing pages?

How to enable the Mortgage Calculator feature?

How do I enable WPL contact forms/activities?

How do I make the Walk Score responsive?

How do I manage social media icons on the WPL front-end?

How do I enable the Google Places feature?

Widget areas and activity positions in the WPL.

How to show/hide property tags?

Notifications

You can edit the content of WPL emails on this menu. Also, you're able to add custom recipients

for all notifications.

Related KB Articles

How do I use the Notification Manager in WPL?

How do I change the sender email/name in WPL notifications?

How do I disable WPL notifications for a certain user/agent?

I don't receive contact notifications. What should I do?

https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/651/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/547/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/584/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/594/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/598/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/688/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/567/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/571/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/762/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/758/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/576/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/696/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/690/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/665/


20

Logs Manager

The WPL Log manager provides a complete log of all events that happen in your WPL website,

such as: adding a new user, add/delete fields in flex, add/delete/update a property, etc. Please

find this article for getting started with the WPL logs manager menu.

Payments

WPL PRO uses an advanced payment system. You can use the payment system of WPL for

selling subscription memberships to users, sell bookings on vacation rental properties, etc.

Please find this article for getting started with WPL Payments.

User Manager

By default, WordPress users are not WPL users. This provides you better managerial supervision

for distinguishing between the agents and the basic users such as subscribers, authors, etc.

https://support.realtyna.com/index.php?/Knowledgebase/Article/View/669/0/how-to-start-with-wpl-payment-system


21

You can activate users in WPL simply by clicking on the "Plus" icon. For specifying user

access and limits you should click on the "Edit" icon, change the settings and save it.

By clicking on each username you can edit selected agent profiles directly without needing to

log in with selected user credentials.

By clicking on the gear icon on top you can manage user fields. For example, you can

disable/enable current fields and also add new fields to user profiles. You can also change the

position of the fields, edit settings of them etc.
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Related KB Articles

Adding new users/agents to WPL

How do I disable WPL notifications for a certain user/agent?

How do I update an agent profile?

What are the different access options for WPL users?

No agent is appearing in the agent/profile page. How do I hide an agent/profile in listing pages?

My Profile

Each agent has their own profile page and they can edit the information to be shown on the

"Agent Activities" or "Listing Details" page. Uploading a profile picture and company logo is

highly recommended so it is good to request that your agents upload their pictures.

https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/543/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/690/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/672/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/565/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/545/
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Note: Do not forget to click on the finalize button after filling the profile page.
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Add Listing

This menu is for adding/editing listings on your website.
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Data Categories

As in the Flex menu, there are some categories for Flex fields available. You can browse them

with a simple click. Based on the Add-ons installed or the customizations you may have, there

will be more or fewer categories.

Some categories might be property type-specific or listing type-specific. It means they're only

available for certain property types or listing types.

Finalize

This is the last step of adding/editing a property. This step is mandatory otherwise the property

will not show on the frontend of the website. In this step, WPL will generate some systematic

data like text search, location text, property cache data, property alias, etc. After finalizing, WPL

will confirm the property if the agent has confirmation access.

Note: Finalizing is required for either adding and/or editing actions.

Mandatory Fields

Some fields are mandatory. This means that in order to finalize the property, these fields are

required and need to be filled in; otherwise, the property cannot be displayed.

Default Units

For some fields, it is mandatory to select a unit. WPL will select default units for each unit type

by default.

Note: You can change the default unit by changing the sort of units (example: the top unit is the

default) in WPL->Data Structure->Unit Manager.

Listing Type/Property Type-Specific Fields

As mentioned before, some fields are listing/property type-specific. For example, "Bedroom" is

a property type-specific field, so it will only appear as an option after selecting a property type

that is relative, such as an Apartment or Townhouse versus an Office or Land.
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Important Items for Adding a Property

These items are important when you are adding a property:

-          Listing Type

-          Property Type

-          Price (and Price Type if needed)

-          Location

-          Geo point on the map

-          Property Description

-          Rooms/Bedrooms and Bathrooms

-          Property Gallery

To have a better interface on your property listing or property show page, it is highly

recommended that you include high-quality pictures for your property.

Related KB Articles

How do I upload multiple videos for a listing and have them appear in a single property page?

How do I change the maximum file upload size for images, videos and attachments?

What Does the "Location Data is Mandatory" Error Mean in Add/Edit Listing Menu?

Bedrooms, Rooms, Price, type etc. is not showing on Listing Wizard or Search Widget!

How do I adjust the property Geo point?

https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/556/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/587/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/528/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/538/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/564/
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Listing Manager

Admins can view and manage all of the listings through this menu. However, agents can only

view their own listings.

Confirm/Un-confirm

In order for a property to appear on the frontend, it needs to be confirmed. Unconfirmed

properties will not show on the property listings or the property show page.

Trash/Restore

By using this action, you can temporarily delete a property from the website. The benefit of this

feature is that you can easily restore the property whenever you want.

Purge

If you want to permanently delete a property, you would use this option. It will delete all of the

property’s data from the database and will also remove all property files and images from the

server.

View

To see the property details on a property show page, you can select to view it. The property

must be confirmed and finalized first in order to view it on the frontend.



28

Edit

To view the property wizard and make changes to the property, you can choose this option.

Mass Actions

For deleting/confirming/purging several or all properties altogether, you can use the mass

action button. Select the desired properties you wish to make changes to and click on "Mass

Buttons" at the top of the page to apply them to all.

the top of the page to apply them to all.

Related KB Articles

How do I change the listing user/agent?

How to purge all Unfinalized listings?

My added listings are not showing in listing pages in frontend.

How to clone a listing?

https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/546/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/753/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/615/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/727/
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WPL Widgets

Widgets are some tools that you can place them on a position of your theme that is called

Sidebar or Widget Area. You can manage your website widgets from WordPress

Backend->Appearance->Widgets or WordPress customizer interface.

WPL also has some widgets that you can use in your theme or WPL widget areas.

Search Widget

Using the Search Widget, your website's users can search on the listings and find their desired

home in less than one minute!

Go to Appearance->Widgets and include "WPL Search Widget" into one of your theme sidebars,

then open it and click on the "View Fields" button to see the below figure:

Drag fields from the bottom bar, drop them into the wide center section and then select the

options of each field. Some fields need extra options for generating sliders or min/max

selectbox+ field type, so remember to fill them in.
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You can also browse other data categories from the top bar and add their fields into the

search widget. After adding your fields, close the lightbox and click on the Save button.

If your website has more than one layout, you can choose one of them through the layout

option of the widget.

Once completed, check your search widget from the frontend of the website.

Note: The interface of the search widget in the frontend is related to something like the width

and height of the sidebar, theme styles, and the fields you have selected.

If you use the WPL28 theme, the frontend of the search widget will be similar to this:

Related KB Articles

How do I add a Search Widget and search options?

How to add the Suggestion Search to the Search Widget?

Widget areas and activity positions in the WPL.

How to change thousand separators in search widget?

How to add location levels as dropdown in search widget?

How to display certain widgets on certain pages?

How to add/remove a search field to/from the search widget in WPL?

How to change location placeholder in search widget?

How to create a profile search/agent search widget on WPL agents' page?

Hierarchical Dropdowns Explained

https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/751/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/781/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/762/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/761/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/709/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/707/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/632/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/608/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/673/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/709/
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Carousel Widget

The carousel is a WordPress widget that is used to showcase properties in different layout

formats (we occasionally add new layouts! Be sure to check the WPL changelog after each

update to see if there is a new layout available). This widget is normally used on the homepage

of the site and can show either random or specific properties.

Go to Appearance->Widgets and include "WPL carousel widget" in one of your theme sidebars.

From here, you will be able to configure all the settings in regards to Title, Target Page, Layout,

CSS Styles, Dimensions, Slides (and slide options), Property Filters, Defining Similar Properties,

Sort and Limits.

Note: The interface of the Carousel Widget in the frontend is related to something like the

width and height of sidebar, theme styles, carousel layout and specifically to property galleries.

Note: If you would like to show only similar properties, select the option “yes” and then

configure the types of similar properties you’d like to show. From this menu, you can choose

things such as “agent,” which will include properties with the same agent, price, property type

and nearby. You can also choose to override listing types from these settings.

Note: If you would like to limit the loading times for your Carousel, enable the “Lazy Loading”

functionality that allows images to load only when they need to.

If you use multiple images layout on the WPL28 theme, the carousel interface will be similar to

the following:
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Related KB Articles

How to show similar/nearby properties in a single property page.

Agents Widget

Using the WPL Agents Widget, you can show some of your website's agents on your website

frontend. You can filter the agents with their user types or memberships and also you can sort

them in your desired format. Please find the following figure:

This widget has two layouts for showing agents named default and list. You can use both of

layouts in different sections of your website.

Favorites Widget

Using the WPL Favorites widget, your website's users can see their favorite listings and then

contact you for those listings or compare them with each other. Please find the following article

as a complete guide for this widget. How to use the WPL PRO favorites widget?

https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/666/
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Related KB Articles

How do I add compare feature for comparing favorite listings?

How can I enable the Favorites Menu in WPL Membership Dashboard?

Links

WPL Links Widget shows the links that are useful for your website's users including login,

register, forgot password, WPL dashboard, logout and Compare links. You have the ability to

enable only some of those links that you need.

Also the widget considers the type of user (Logged in user or guest user) and shows only

needed links.

Unit Switcher

Unit Switcher widget can be used for providing an ability to website users to change the active

currency of the website. For example website's users can change the currency from USD to EUR

and then see all the prices in Euros instead of US Dollars. Please check the following article as a

complete guide for this widget. How to enable the WPL currency switcher?

Widget Shortcodes

All WPL widgets can work as a shortcode as well. It means you can put the widget shortcode in

any position of your website pages. Also, you can use the shortcode for placing it inside of page

builder plugins like Visual Composer, Beaver Builder, Divi builder, etc.

https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/706/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/780/
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Related KB Articles

How does the WPL shortcode wizard work?

https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/591/
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Also, you can place all WPL widget shortcodes using the WPL shortcode wizard which is

located in WordPress editor ([W] icon).

WPL Activities

Activities are small codes of WPL that can be placed on different WPL positions. For example,

gallery activity is responsible for showing property images and it can be placed on Property

Listing and Property Details pages. So if you want to disable gallery activity in property listing

views, you just need to disable its activity from WPL->Activity Manager menu.

Also,  each activity has some options and you can configure those options to reach your desired

feel and functionality.

Related KB Articles

Enabling/Disabling/Sorting WPL Activities.

How do you modify and change settings for items in the WPL Activity Manager?

How to disable/enable certain activities in certain pages?

Activity Positions

Activities can be placed in different sections. We call them activity positions. By default, we

configured all WPL activities and their positions so all of them are ready for use out of the box

but if you need to add some activities in different positions, you can take a look at the following

article.

List of activity positions in the WPL.

https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/547/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/651/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/710/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/762/
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Agent Info

This activity shows agent information on Property Details, Profile Show and PDF Flyer Pages.

You can find all instances of this activity in the WPL->Activity Manager menu. Please find the

following figure:

You can change the activities configurations if needed by clicking on the edit icon.

Note: If you have Multiple Agents add-on installed, then the agent info activity will show all

agent’s information.

Related KB Articles

How to add link to email images using mailto option?

https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/611/
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Google Maps

Google Maps is an activity for showing properties' markers on the map. You can see it on the

property listing, property details, complex listing and details (required Complex Add-on) and

also neighborhood details pages (required Neighborhoods Add-on).

You can find all instances of the Google Maps activities on WPL->Activity Manager by searching

for googlemap.

Note: Users may change the maximum daily usage for their Google Maps API in the Googlemap

activity. Use caution when changing this number, as it may cause charges on your Google Map

Platform account.

By default, there are two instances for this activity. One for the property listing page and

another one for the property details page. So you can simply disable the property listing

instance if you want to hide the Google Maps on search results pages or you can change its

position to show on the bottom of the page.
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Also, there are many options for this activity and you can configure them based on your needs.

You may see even more options on Google Maps activity if you have APS add-on, Demographic

add-on, WPL PRO installed on your website.

1. To choose or edit your Google Markers, you have 2 options.

2. You can choose/upload a marker by navigating to Data Structure > Listing Types > Google

Icon

You can select from Advanced Markers by following Settings > Advanced Markers > Enable.

Here you can choose different markers as well as assign them colors. Remember to save.

Many features are included in the Google Maps activity. Please find the related articles section.

Related KB Articles

How to change default location of Google maps from US to another location?

"Oops! Something went wrong" error on Google Maps!

How to get a Google Map API key?

How to disable Google Maps Activity in Listing Pages?

How do I enable the Google Places feature?

How to upload new Google Map Marker?

What is default latitude, longitude and zoom level in Google maps activity?

https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/724/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/717/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/640/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/584/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/571/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/756/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/554/
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HTML

HTML Activity is a content activity for showing any kind of plan and HTML contents in WPL

activity positions. For example, if you want to show a call to action button in the property

details page, you can put your content in this activity and place it on your desired position.

Also this activity is able to run shortcodes so you can place any kind of shortcodes using this

content activity.

Related KB Articles
How can I enable the Favorites Menu in WPL Membership Dashboard?

Listing Attachments

As you know you can add a different kind of attachments to a property using WPL->Add / Edit

Listing menu including zip files, PDF files, etc. the Listing Attachment activity is created for

showing attachments of listings on the property details page. It's configured and enabled by

default after WPL installation.

You may want to change the activity title, position or hide it for certain users.

Listing Contact

This activity displays a contact form on the property details page so your website visitors can

contact the property owner / agent by filling a simple form.

https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/780/
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Related KB Articles

How to enable WPL contact forms/activities?

How to add captcha to the WPL contact, Membership login and register forms?

I don't receive contact notifications. What should I do?

Listing Gallery

This activity shows property images on the frontend of the website. It's included in the property

listing and property details pages. It has some layouts for showing image galleries in different

styles.

In the following figure, you can see Listing Gallery activity on property listing pages. Its layout is

Simple and loads only featured images of the property.

You should keep the layout simple because it will have good effects on page speed due to

loading fewer amounts of images.

https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/598/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/685/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/665/
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The following figure shows the Modern layout of this activity that is used in property details

pages. It creates a slider from the images and also it will show full images on a lightbox when

users click on the image. It's a modern, responsive and optimized layout.
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Also you can see another instance of this activity in the Listing Manager menu on WPL

backend or frontend.

Related KB Articles

How to create the image gallery for floor plan category images?

How to enable Modern/Gallery/Lightbox layout for property images in property details page?

Why listing images don't show on front-end of website?

How do I change the maximum file upload size for images, videos and attachments?

What is the difference between image resize methods?

How to change image size on listing and single listing page?

How do I enable the Watermark feature of WPL?

How to show/hide property tags?

Why my thumbnail photos don't change in my listings?

Listing Links

This activity is for showing property related links and icons including Share on Facebook,

Twitter, Linkedin, Pinterest and also link to PDF Flyer of property, CRM, Request forms etc.

You can find instances of this activity simply by searching links on WPL->Activity Manager

menu. You can find one of the instances in the Property Details page.

https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/743/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/684/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/738/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/587/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/558/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/530/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/593/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/758/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/699/
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You're able to enable/disable the icons that you see in the above figure. You need to edit

the activity instance on WPL->Activity Manager menu and check or uncheck the options.

Related KB Articles

How do I manage social media icons in front-end of WPL?

How to enable WPL social network options?

How do I enable the PDF feature of WPL PRO?

How to manage WPL PRO PDF flyer?

Listing Open Dates

As you may know, you can add open house properties in WPL. For Open house properties, you

can insert open dates and comments as well. This activity is used for showing those open dates

on the property details page. Please find the below figure. It will show on Property Details

page.

https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/567/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/667/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/569/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/671/
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Following figure will show on Add / Edit Listing menu.

Listing Rooms

As talked earlier, WPL has an option for adding property rooms' information. You can insert the

property rooms on Add / Edit Listing menu and then those rooms will show on the property

details page using Listing Rooms Activity.
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Listing Videos

WPL has an advanced feature for adding embed videos or uploading video files for properties

and the Listing Videos activity is for showing the videos on the property details page.

You can find the video activity by searching video word on WPL->Activity Manager menu.

Please find related KB articles for a complete guide.

Related KB Articles

How to upload videos for a listing and show them in single property page?

https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/556/
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QR Code

Quick Response Code is a barcode technology for moving data to mobile/tablet devices very

fast. Using the QR Code module of WPL, a QR barcode will show on your website's property

details page and users can scan it using their mobile phones and save the property link on their

device or share the property link.

Also by default, an instance of QR code will show on PDF flyer and so can print it. This way

others can scan the barcode and open the full property details page on their devices very

quickly.

Walkscore

It's a feature that shows the walk score of the property using Walkscore.com website services.

You should get an API key from the data provider website and then enable the activity to show

the results on the property details page.
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Related KB Articles

What is the "No Walkscore license key!" message?

How to make the Walk Score responsive?

User Contact

It's a contact activity that shows on the Profile / Agent Show page in the frontend. Users can

contact the current agent by filling the User Contact form and then an email will send to the

agent.

https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/575/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/688/
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Related KB Articles

How to enable WPL contact forms/activities?

WPL Frontend Views

WPL Shortcode Wizard

WPL has a wizard form for

generating shortcodes. You can see

and use it on the WordPress editor.

After clicking on the WPL icon

button, a lightbox will be open and

provide you the capability of

generating shortcodes.

You can see the lightbox figure below:

https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/598/
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WPL Shortcodes

Although you can use the wizard to generate shortcodes, we are going to explain WPL

shortcodes below:

[WPL]: It is used as the main WPL shortcode for showing property listings.

[wpl_property_show]: It is for creating a property show page. You should assign a listing ID of a

property to this shortcode. For example: [wpl_property_show mls_id="1006"] where 1006 is

the listing ID of the property.

[wpl_profile_listing]: It is for creating a profile/agent listing view.

[wpl_profile_show]: It is for showing the profile of a specific user/agent. It has a parameter for

specifying user/agent id. For example: [wpl_profile_show sf_select_user_id="1"] where 1 is ID

of the user.

[wpl_my_profile]: It is for showing the profile form of a user/agent in frontend. This shortcode

has no parameters. Just put [wpl_my_profile] in the page content.

Each shortcode has more parameters that you can see by using the shortcode wizard.

Property Listing

This is an interface for showing the list of properties to site visitors with pagination, sort

options, and the ability to change by parameters set in the search widget.

This interface also opened after searching by search widget so you may know it by search

results page. The search widget can be placed on the same page or on another separated page.
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Note: The interface of the frontend might change based on the theme you are using.
Some activities may be added or removed as well.

You can create various types of property listings using the shortcode wizard. For example, you

can create a menu for showing sale properties or rental properties. You can even create a menu

for showing "hot" or "featured" properties.

Related KB Articles
How to manage property listing style switcher (List/Grid option)

How to sort listings or navigate to other search results pages without refreshing the page?

How to sort property listings by Property Type and/or Listing type?

Enabling the RSS feed feature in WPL

How do I add the Print feature in the listing page?

How to enable/disable the cursor hover effect of the property listing?

How to hide zero values on property listing and property show pages of WPL?

How to show only map view on a listing page / How to hide list view on a listing page?

https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/605/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/767/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/759/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/643/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/705/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/764/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/597/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/680/
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Property Details Page

This is the interface that shows detailed information about a property.

You can see property categorized data, location details and Google Maps, Property Images,

Agent info and contact forms, etc. on the Property Details page.

Related KB Articles

How to hide zero values on property listing and property show pages of WPL?

How to add Virtual tour to the Property show page?

How to speed up property details page?

How to change property details layout to new layout?

How to insert shortcode inside of the description of property?

How to remove the country name from property location?

How to change main color of WPL frontend?

How to hide property address?

https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/597/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/736/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/785/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/725/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/723/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/733/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/708/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/649/
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How to adjust property URL/Alias/Permalink?

What is the difference between property page title and property title?

How do I show the "Call for Price" text in WPL PRO?

Profile Listing

This interface is used to list the agents. All agents that have access to create a public profile will

be shown here. You can change the access rights for each agent through WPL->User

Manager->Edit.

Note: The interface of the frontend may change based on the theme you are using. Some

activities may be added or removed as well.

Related KB Articles

Creating agent profiles listing pages and single agent profile show pages on the front end

No agent is showing on the agent/profile show page / Hiding an agent/profile in listing pages

How to create a profile search/agent search widget on WPL agents page?

https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/668/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/631/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/592/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/544/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/545/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/673/
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Adding new users/agents to WPL

How to update Agents' profile information?

https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/543/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/672/
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Profile Show Page

This interface is for showing one specific agent's properties and viewing the detailed

information of that agent.

My Profile Page

It's for showing the profile form of the agent in frontend. You just need to insert the related

shortcode into the page content as talked earlier.

Also if you have Membership add-on installed, the profile form will show on the Membership

dashboard. Logged in users have the ability to update their profile information, images,

biography, etc. from the frontend.

WPL Help

Internal Help

Almost all of WPL menus on the backend has a help tab on top of the page, you can find a quick

help and some articles related to the current page in this tab. If you need help on any WPL

page, the first thing is to check the Help tab on top of the page. Some pages have an Introduce

Tour as well.
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Knowledgebase

We have a rich Knowledgebase for WPL and you can find some interesting topics in it. WPL KB

articles are shown on WPL dashboard and can be filtered so if you have any questions, please

look there first.

You can find all the WPL KB articles by clicking this link:

https://support.realtyna.com/index.php?/Default/Knowledgebase/List/Index/28/wpl

https://support.realtyna.com/index.php?/Default/Knowledgebase/List/Index/28/wpl
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Important Articles

These are the most important KB articles that you should read:

System Requirements for using WPL

- How do I translate WPL?

- How to use multilingual feature of WPL PRO to create a multilingual real estate website?

- How to hide zero values on property listing and property show pages of WPL

- How to insert sample properties into WPL PRO

- How to enable Mortgage Calculator feature?

- How do I show the "Call for Price" text in WPL PRO?

- How do I create new fields and edit current fields in WPL? How do I use the Flex menu?

- How to enable/disable WPL measuring units such as acre, mile, currency, units etc?

- Creating agent listing profiles and agent profile show for menus on the frontend.

- Adding new users/agents to WPL

- Enabling/Disabling/Sorting WPL Activities.

- Developer related articles.

- How to upload some videos for a listing and show them in the single property page

- How to use Location Manager in WPL

- How do I add/remove location levels to WPL?

- How to use WPL Visual Composer Elements?

- How to use WPL Divi Builder Elements?

- How to enable/disable the cursor hover effect of the property listing?

- How to change a thousand separator in search widget?

- How to filter listings using WPL shortcode?

https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/529/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/537/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/601/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/597/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/596/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/594/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/592/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/541/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/542/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/544/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/543/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/547/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/550/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/556/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/527/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/562/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/771/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/770/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/764/
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FAQ

You can find some of the frequently asked questions in this section.

- What is the difference between image resize methods?

- How to update WPL PRO?

- What is default latitude, longitude and zoom level in Google Maps activity?

- How to change user/agent of a listing?

- No agent is showing on agent/profile show page! Hiding an agent/profile in listing pages.

- Bedrooms, Rooms and some other fields are not showing up for new listing types or property types!

- How do I create property type and listing type specific fields in WPL?

- Bedrooms, Rooms, Price, type etc. is not showing on Listing Wizard or Search Widget!

- Property details page is not opening!

- How to change images size on listing and single listing page?

- What Does the "Location Data is Mandatory" Error Mean in Add/Edit Listing Menu?

- How do you upgrade WPL basic to WPL PRO?
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https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/540/
https://support.realtyna.com/index.php?/Default/Knowledgebase/Article/View/539/
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